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Using Dreamweaver CC 

2 – HTML 
The World Wide Web is based on HTML (Hypertext 

markup language). Although Dreamweaver works fine as 

just a WYSIWYG editor, it is still worthwhile for 

Dreamweaver users to be familiar with HTML for a 

couple of reasons. Firstly, there are times where it may be 

useful or even essential to edit some of the HTML code in 

a document while you are working with Dreamweaver. 

Secondly and more importantly, learning a bit of HTML 

ensures that you understand how HTML works. This will 

enable you to design pages in Dreamweaver that work 

better on the web and will also make it easier to understand what is going on when web pages 

have problems or don’t appear the way you expected. Many professional web developers use 

Dreamweaver primarily for editing HTML rather than using the WYSIWYG editor. 

Note If you have already learned HTML in the past, this will be a good opportunity to refresh your 
memory. If you have never learned HTML before then it could be beneficial to spend a bit of time 
learning the fundamentals. There are numerous good guides to HTML online.  

One important thing to understand about HTML is that strictly speaking, it is only intended to 

be used to define how your documents will be structured. It is not intended to be used to 

determine how the page will look. Content and presentation are separate. For instance, while 

HTML can be used to specify that your page has paragraphs, headings, lists and hyperlinks it is 

not intended to specify how those various elements will look. As HTML became more widely 

used, elements for presentation such as the Font tag began to be introduced (use of the font tag 

and other similar tags are no longer encouraged). At the time there was no better way of 

formatting a web page but it wasn’t a good solution as it led to web pages with complicated 

code that was prone to problems. 

With the introduction of CSS (cascading stylesheets) in the late 90s it is now possible to create 

web pages where the content is truly separate from the presentation of the page. You can use 

HTML solely for the purpose of setting up how your page is structured while leaving the 

formatting of your page up to a CSS stylesheet. This allows for web pages that are designed 

much better and are easier to maintain. Recent versions of Dreamweaver have placed increasing 

importance on the use of stylesheets for formatting and these exercises will likewise emphasise 

the practice of using stylesheets for the formatting of your websites. What this will mean is that 

when we create web pages in these exercises, we will often set up a page, but not worry too 

much about formatting it until we have set up styles for the document.   
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Exercise 1 –  Sections of a document 

1) Open Dreamweaver if it isn’t already open. 

2) From the startup screen if it is showing select the option to create a new HTML document.  

You can also select New from the File menu [Ctrl [N] and then select HTML from the list of 

page types with <none> selected for the layout. A blank page is created. 

  

3) Switch to Split view so that one half of the editing window shows the HTML. You can go to 

the View menu and select Split to decide where the HTML half of the window will be 

positioned. In the following example it is beneath the design view. 

 

The Elements that you can see in the HTML are common in most HTML files and are described 

below. 

The first line (DOCTYPE), specifies which version of HTML is being used in the document and 

helps a web browser to display your page properly. The HTML specification recommends that 

each HTML document start with this. 

An HTML tag specifies where the code begins and at the end of a document, a closing tag 

specifies where the code ends. Notice that the closing and opening tags are the same except that 

the closing tag includes a forward slash, or / character. 

The HEAD section of the document contains information that is important to the document, but 

won’t actually appear within the document. In the case of this document, the head section 

includes a page title (in the TITLE tag) as well as a META tag which specifies the character set 

being used in the document (in this case standard English characters). 

The BODY section contains the actual document itself, which in this case is currently empty. 

At the bottom of your screen there should be a properties panel. If it’s not visible you may be 

able to click a Properties tab at the bottom to display it. 
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4) You can also display the properties panel by going to the Window menu and selecting 

 

Tip If the layout of dreamweaver has been changed and 
you want to revert to the standard layout, select the 
Standard option from the list at the top of your 
screen. 

The first thing we’ll do is edit the page title. 

5) From the File menu select Page Properties. 

6) Choose Title/Encoding from the options on the left 

 

7) Replace the text Untitled Document with Sample HTML Page and click OK. 

If you look in your HTML code, you will notice that the line 

 

Has now changed to 

 

This also happens in reverse so that if you make changes in the HTML code directly, it will 

update in Dreamweaver’s other views. 

TITLE is an important element in an HTML document. If someone bookmarks a web page or 

adds it to their favourites, the title of the page is normally used as the label by default. Also, if 

someone searches in Google or another search engine, the document Title is normally the first 

thing to appear in the search results. A title of 3 to 5 descriptive words is good as it will increase 

the likelihood of people finding your site in web searches. 

Exercise 2 –  Element Attributes 

HTML Elements contain additional information using Attributes, though they are not necessary 

for some tags. We’re going to enter a heading on the page and use the align attribute to position 

it in the centre of the page. 

1) In the HTML code, create a blank line between the <body> and </body> tags. 

2) Type <h1>. h1 indicates a level 1 heading which should be the main headings in your 

document. Other numbers are used for subheadings. 

You may have noticed as you began typing the tag that a list of tags appeared. This is to help 

you with HTML by allowing you to select a tag from the list. If the tag you want is already 

selected in the list, you can press [Enter] to complete the tag. h1 isn’t a lot to type though so you 

probably didn’t need the help this time. 

Since we have created a tag to indicate the start of a heading, we will also need a tag to indicate 

where the heading ends. Most tags require a closing tag to tell a web browser where to end that 

page element (in this case where the end of the heading is). 

The closing tag for a <h1> tag would be </h1> 
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3) Start typing the tag by typing </ 

As soon as you type the forward slash / Dreamweaver will recognise that you are closing the 

previous tag and complete it for you. If you forgot to add a closing tag or mis-typed the closing 

tag, a web browser might thing that everything until the end of the document is still part of the 

heading and display it accordingly. 

4) Click between the opening and closing heading tag to make sure you are ready to type 

between them. 

 

5) Type Sample HTML Document between the opening and closing h1 tag. 

 

As you make changes in the HTML part of the screen, the design part of the screen will update 

to show those changes. 

 
 

6) In the HTML, click in the heading tag right after the number 1 as shown. 

 

7) Type a space and then type align= "center" so that it appears as below. 

 

A tag attribute contains two parts. The name of the attribute and the value of the attribute 

separated by an equal sign. The value should be surrounded by double quotes. In the above 

example, ALIGN is the name of the attribute while center is the value of the attribute. For people 

outside USA, note the US spelling. HTML only recognises US spelling so putting ‘centre’ won’t 

do anything. The same also applies for words like COLOR (colour) and GRAY (grey). 

8) An element can have more than one attribute. Change the line of HTML so it looks like the 

following (with an underscore _ instead of a blank space. Holding shift while pressing the – 

key on your keyboard will add an underscore.). 

 

The ID tag doesn’t change the heading. It gives it a name. This is useful later on when it can 

become important for HTML elements to be referred to individually from elsewhere. 

Note It doesn’t matter which order attributes appear in so  
<h1 align="center" id="main_heading">  
is the same as 
<h1 id="main_heading" align="center">. 

9) Add two lines of HTML after your heading as shown. 

 
<h1 align="center" id="main_heading">Sample HTML Document</h1> 

<h2>Subheading</h2> 

<p><img src="http://www.oneil.com.au/pc/dw_logo.png" align="right" 

height="47" width="47" alt="Dreamweaver Logo"> 

A paragraph of text with a <a href="http://www.oneil.com.au/pc/">link to a 

website</a> and an image which is aligned to the right of the page</p> 

The design section of the page should look like the example below. Normally the design view 

does a pretty good job of showing how things will look in a web browser but not always. To 

preview the page in a web browser but we need to save it first. 
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10) From the File menu select Save or press [Ctrl] [S] to save the file. 

11) Select a location to save the file and enter html_practice.html for the file name. 

 

A few things to remember about filenames in websites (this applies not only to HTML files but 

to other files that will be used in your site, such as images and stylesheets). 

 Avoid uppercase letters. If you name a file with uppercase letters such as Document.html, 

you will have to type it exactly the same every time you refer to it. Referring to it as 

document.html won’t work in a website. It might work ok while you’re testing it on your 

own computer since Windows doesn’t make a distinction between uppercase and lowercase 

filenames. When it’s on the web though, it might be on a computer running Unix or Linux 

where case does matter in filenames. Keeping names all lowercase makes things a bit easier 

and reduces the chance of broken links. 

 Don’t use spaces since some web servers don’t allow filenames with spaces. File names 

made up of more than one word are fine but use underscores ( _ ) instead of spaces. Holding 

down the Shift key and pressing the dash/minus sign key – will give you an underscore. 

 When you are saving the main page in a website, it is best to call it index.html. This is the 

standard name for the main page on a site. If you type http://www.oneil.com.au/pc/ in to 

your web browser it will go to http://www.oneil.com.au/pc/index.html since it assumes 

index.html is the main file. Basically, if your main page is called index, it allows you to drop 

the filename off your site’s address, making it shorter and easier to type. 

1) Click Save to save the file.   

http://www.oneil.com.au/pc/
http://www.oneil.com.au/pc/index.html
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Exercise 3 –  Previewing the Document 

1) Click the Real-time Preview icon in the bottom corner of your editing window.  

 

A list of web browsers will appear. If you have more than one web browser installed on your 

computer, you can test your web page in each one, which is a good idea if you want to make 

sure it works well in all browsers. 

2) If no browsers appear in the list or you want to add another browser that you have installed 

on your computer, click on the Edit List option. 

3) Preview the page in your primary browser. Below are examples of how the page looks in 

Mozilla Firefox and Google Chrome. 

 

 

 

4) You can also preview your page to see how it would look in a browser by changing from 

Design view to Live view. This gives you a browser preview without having to leave 

Dreamweaver. Some features of Dreamweaver require you to be in Live view but for now 

we will work in Design view. 

 

 

5) Change back to Design view and close the file when done.   
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Exercise 4 –  Quick Revision 

1) Write True or False next to each of the following statements. 

a) It is essential for attribute values to have quotation marks around them. 

b) Only US spelling is recognised in HTML. 

c) It doesn’t matter if tags are written in upper case or lower case letters. 

d) The contents of the Head section will not appear in the web browser’s main window. 

2) For each of the following lines of HTML, correct the error and explain why you believe it is 

an error.  
<p><b><i><a href="prices.html">Our price list</b></a></i></p> 

Correction  __________________________________________________________________  

Explanation  ________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

<img src="portrait.jpg" alt="Photo" width="300" height="150" border="0> 

Correction  __________________________________________________________________  

Explanation  ________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

<h1 align="centre">Bob's Garden Services</h1> 

Correction  __________________________________________________________________  

Explanation  ________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

<p><align="center">Low prices every day!</align></p> 

Correction  __________________________________________________________________  

Explanation  ________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  

 ___________________________________________________________________________  
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Shortcuts Learned 

[Ctrl] [N] Create a new file 
[Ctrl] [S] Save file 
[Ctrl] [F3] Hide / Display the properties panel 
[F5] Refresh the editing window 
[F12] Preview the page in your primary browser 
[Ctrl] [F12] Preview the page in your secondary browser 
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Exercise 5 –  Quick Revision - Answers 

1) Write True or False next to each of the following statements. 

a) It is essential for attribute values to have quotation marks around them. False – it isn’t 

actually essential but it is recommended 

b) Only US spelling is recognised in HTML. True 

c) It doesn’t matter if tags are written in upper case or lower case letters. True, and it used 

to be common for people to write tags in uppercase. These days though, the HTML 

specification prefers lower case. 

d) The contents of the Head section will not appear in the web browser’s main window. 

True – the head section contains information that is used elsewhere. E.g. page title or 

keywords that might be used in internet searches. 

2) For each of the following lines of HTML, correct the error and explain why you believe it is 

an error.  
<p><b><i><a href="prices.html">Our price list</b></a></i></p> 

Correction  

<p><b><i><a href="prices.html">Our price list</a></i></b></p> 

 

Explanation 

Tags should be closed in the order in which they were opened. I.e. the last tag opened should be 

the first one closed. The first one open should be the last one closed ____________________  

<img src="portrait.jpg" alt="Photo" width="300" height="150" border="0> 

Correction  

<img src="portrait.jpg" alt="Photo" width="300" height="150" border="0"> 

 

Explanation  

In the border attribute there was a closing “ before the number but there wasn’t one after it. 

Leaving the quotes out altogether is ok (but not recommended). Putting quotes before and after 

is also ok. Having quotes on only one side is not ok. 

 

<h1 align="centre">Bob's Garden Services</h1> 

Correction  

<h1 align="center">Bob's Garden Services</h1> 

Explanation  

This would only work if US spelling was used for center. If you spelled it as centre, your web 

browser would not recognise it and the alignment would be ignored. So it would end up left 

aligned instead. 

 

<p><align="center">Low prices every day!</align></p> 

Correction  

<p align="center">Low prices every day!</p> 

Explanation  

There is no align tag in HTML. Instead, paragraphs are aligned using an attribute in the <p> tag. 

When the paragraph tag is closed with </p> it also closes any of the attributes within that tag. 


